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In installment 1 we discussed how GoldMine
synchronization works, its advantages and
disadvantages, and how you know if you
might have a problem.

In installment 2 we discussed the ways in which sync problems occur. You saw that
many “synchronization” problems are really database or data problems which are
manifested by the synchronization process.

In this third and final installment we discuss how to correct your GoldMine
synchronization problems.

How do I correct sync problems?

INSTEISCIENN - Attemptto diagnose the problem

GoldSync Problems - A White o Bearing in mind that the problem could have many causes as

Paper ( Part III ) noted above, review the sync logs, inspect the files, and otherwise
do what detective work you can to determine the cause of the

The In’s and Out’s of INI problem. This is not an easy task. You may want to call VMI for

. help in this area.
Tips, Tricks & Things

o Use diagnostic tools to help identify the problem. A tool called

Query Tips “Sync Spy” is built into GoldMine. It will show you the “Sync
Updating Contacts with the stamp” of various Contactl and Contact2 fields. There are other
Import Wizard third party diagnostic tools including many written by VML.
Filtering on Other Tables o If you are unable to diagnose the problem, you can often cure the

sync problems without even knowing what caused them using the
following techniques

e Set back the sync date

o Manually set the From date and time to a time earlier than the last
date when you are confident that all data was properly synched.

o Ensure that you have not locked any records or documents, that you
have the proper sync settings, etc.

o Run synchronization to “pick up” individual updates that were missed
in prior synchronizations.
( Continued on Page 2 )
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( Continued from Page 1)

Be aware that, depending on where the
data is missing, you may have to set back
the sync dates on the sync server, on the
remote system(s), or both. In most cases
it is safest to set back the date on all
systems.

e Correct data problems

Pack/rebuild your files.

Use dSalvage or other utility to find and
fix BLOB errors (as mentioned above,
BLOBs are Binary Large OBjects). In
GoldMine, BLOBS are the Notes fields. If
a process locks with a BLOB error on a
particular transaction, then that transaction
(or the one following it) is probably the
offending record. An easy cure is to:

= open GoldMine and go to that
record.

= edit the record and copy the notes
onto your Windows notepad.

= delete the note from the
transaction and save the change.

= open the record in edit mode and
paste the notes back in from your
Windows notepad.

= At this point, the BLOB error
should be cured.

Use VMI utilities to remove duplicate
Contact2 records in your database (Please
call VMI if you suspect that you have this
problem, or if you simply want to have your
files checked for this problem for peace of
mind).

Take other steps as necessary depending
on the nature of the corruption: Any
database can become corrupted in dozens
of ways. The corruption will cause sync
problems. It is beyond the scope of this
white paper to discuss all possible forms
of database corruption, but VMI engineers
are expert at detecting and correcting such
problems. Please call us if you need help
in this area.

Delete transaction log entries

Identify the exact RecID of the wrongfully
deleted record(s).

( Continued on Page 3 )
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( Continued from Page 2 )

@)

Find and delete the corresponding deletion
transactions in the transaction log of every
computer that was affected.

WARNING: If you miss a single
computer, and if that computer later syncs,
you may need to repeat the entire process.
To prevent this problem, you should “turn
off” sync in the GoldSync administrator for
all remote databases, and “turn on” each
only after you have confirmed that it is
“clean.”.

This is difficult, but far less difficult than
the protocol for deleting the entire
transaction log.

o Delete entire transaction log

@)

All remote computers and the sync server
must be backed up.

All remote computers must sync all of their
data to the sync server. There should be
no transmission sync filters.

There must be no further entries after this
sync.

Transaction logs must be deleted from all
remote computers and from the sync
server.

The sync server sends deletion filters as
needed.

The sync server sends a transfer set dated
as far back in time as necessary (depending
on your analysis of the data problems).

This is a very difficult protocol in practice.
If even one remote computer does not
follow the protocol, then the problems
could be re-introduced.

e Full sync restore

@)

All remote computers and the sync server
must be backed up.

All remote computers must sync all of their
data to the sync server. There should be
no transmission sync filters.

Delete all data and all transaction logs from
all of the laptops.

Set back the sync date of the sync server
to day zero and build transfer sets for each
remote computer.

o Completely re-build every remote
computer using the new transfer sets.

About the author

David Lee is a recognized expert in CRM data
synchronization, and has configured synchronization for
hundreds of GoldMine (and other) CRM systems.

His company, VMI, has worked in over 1,000 CRM
implementations since 1985. Almost half of these use the
synchronization feature. VMI has actually hosted
synchronization for more than 2,000 users over the last 5
years. These clients synchronize data directly to VMI
servers. VMI also supports synchronization for many others
through remote access to their own servers. In addition,
VMI has used synchronization internally since 1993. This
gives us more real-world synchronization experience than
any other organization (including FrontRange itself).

Mr. Lee has designed dozens of tools and processes to
analyze and correct synchronization problems, including
SyncRx (whose logic was later incorporated into the
GoldMine system itself).

The In’s and Out’s
of INI

A guide to understanding and
troubleshooting GoldMine’s

UserID.ini

by
Kevin Day

If you've followed the GoldMine support forums ( or read
this newsletter ) for long enough, you will have seen
references to the infamous GoldMine USERID.ini files. You
also have probably seen many ‘experts’ suggesting that
most GoldMine woes can be fixed by deleting the UserID.ini
file.

While it is true that UserID.ini files are at the root of much
evil and strange behavior in GoldMine, deleting the files
outright is very rarely the correct solution. This article
aims at peeling back the covers ( a bit ) of the UserID.ini
file and providing a troubleshooting strategy for identifying
and fixing the real problems in a UserID.ini file — without
losing all of your hard earned settings.

What is an INI file

( If you are already familiar with INI files, you may want to
skip to the next section )

( Continued on Page 4 )
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( Continued from Page 3 )

Back in the good old days of Windows 3.0, Microsoft
realized that they needed an effective mechanism for
capturing user preferences. The Microsoft developers
decided to use a human readable text file with an INI
extension to capture these settings ( for those who don’t
spend a lot of time around Windows command line geeks,
INI is pronounced ‘ih-nee’ ). Human readable files have
some great advantages ( especially when used with a new
and incredibly unstable operating system ) as well, they
have a couple of drawbacks.

Advantages of human readable INI files:
Easy to read and edit without special software

Easy to add prototype functionality without adding
user interface components

Relatively easy to fix if they get corrupted
Disadvantages of human readable INI files:
Inefficient with disk space

Much slower to read (and much, much slower to
write)

Very complicated to make updates dynamic
INI file structure

INI files are simple text files that adhere to a relatively
simple ( but very flexible ) format. An INI file is divided
into what are known as sections. Each section is identified
by the name of the section, surrounded by square brackets,
as follows:

[Kevins Section Name]

All data following the section title, up to the next title, or
the end of the file, belongs to that section.

Each section contains a
set of keys and values.
Each key/value pair is
listed one per line beneath
it's associated section
name, separated by an
equal sign. Each
statement line is ended
with a chr(10)+chr(13) better known as CRLF as follows:

Editors Note

You should try to avoid having

spaces in either the key or the
section header.

[Kevins Section Name]

Some Key=Some Value
Some other Key=Some Other Value

INI files can contain comments ( preceded by a semi-
colon ) and blank lines, which are ignored. For example:

4 The GoldMine Advisor- February 2006

[Kevins Section Name]

Some Key=Some Value
; this is a comment

; there’s a blank line above this comment
Some other Key=Some Other Value

That covers the entire
basic INI file structure.
The actual names of
the sections and keys
are completely up to
the developer ( with
certain limitations —i.e.
you can't use an equal
sign in the name of the

key ).

Editors Note

A comprehensive listing of most of

the UserID.ini and GM.ini settings can
be found in The Hacker’s Guide to
GoldMine 6.x series of books.

How does GoldMine use INI files

GoldMine uses INI files to capture global and user specific
settings. Global settings are captured in a file called
GM.INI ( stored in your root GoldMine application directory
on the network ). User specific settings are stored in an
ini file named with the GoldMine UserID ( that's why we
always talk about UserID.ini, even though there isn't really
a file by that name ). So, my UserID.ini file is KEVIN.INI.

The GoldMine developers have decided on a set of section
names that they use to break keys and values apart into
manageable chunks ( these section names have evolved
over time ). For example, all of the settings related to the
Calendar user interface are in a section called [CalObj].

The following summarizes the most common UserID.ini
sections and what they are used for ( there are many
others, so don’t take this list as exhaustive ):

GoldMine

General configuration items (which contact set the user
opened last, their recent filter list, date related settings)

CalObj

Store and configure all aspects of calendaring, including
user interface settings ( which tab is displayed, which user
is selected, split bar positions )

Internet

All settings for retrieving and displaying email, including
server names, passwords ( encrypted ), settings for the
Mail Center user interface ( i.e. where the split bars are
positioned, which column is sorted, etc... )

GM_MAIL_READER

A few extra settings for the email center

( Continued on Page 5 )
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ProcMon

Settings for the process monitor, including whether logs
get created when the process monitor runs

OpMgr
Project and opportunity manager user interface settings
AL*Tab

Where * is ‘Actions, Email, RealTime, etc... - the user
interface settings for the activity list

Tooll6

Settings for the GoldMine toolbars ( NOT the taskbars ) —
including which buttons to show, where the toolbar is
displayed, etc...

So where can all of this go wrong?

GoldMine does not check the values stored in the INI
files to ensure that they are valid ( an example is if a value
in the INI file specifies a negative window width ). GoldMine
assumes that because it wrote the INI file ( which it does
in most cases ), then the data in the INI file can’t be invalid.

This is a reasonable assumption in most cases, but there
are times when GoldMine does NOT write valid data to the
INI file, or the INI file becomes corrupted or a user manually
changes the INI file to contain an invalid value. If this
happens, then GoldMine can exhibit all sorts of interesting
behavior. Some examples:

GoldMine may crash without warning ( this will usually
occur during launch, but could also happen when bringing
up a new GoldMine window ):

GoldMine crashes without warning

GoldMine windows display oddly ( for example,
the tabs along the bottom of the Calendar don't
display )

Windows may appear, but be way outside the
regular viewable area in GoldMine

Troubleshooting Strategy

Often times, the knee-jerk response to an unexplainable
problem is to delete the UserID.ini file and see if that fixes
the problem. This is a fine first step, but it very rarely is
the entire appropriate solution to a given problem. In the
following section, I outline a methodology for determining
exactly what in the UserID.ini file has become corrupted,
and how to fix it.

Finding what’s wrong

The primary goal for troubleshooting a problem with a
UserID.ini file is to determine which section, key and value
are involved in turning the problem off and on. We do this
by selectively removing sections and/or keys until the
problem goes away, then add them back in to confirm that
we have truly identified the problem. To keep this
somewhat efficient we use a divide-and-conquer ( binary
search ) approach. Here is the process:

Make sure the problem still exists

The first step of this strategy is to make sure that the
problem is actually repeatable. Open Goldmine and re-
produce the problem a few times, just to make sure that it
is indeed repeatable ( there’s nothing more frustrating than
debugging an INI file, only to find that the problem
somehow corrected itself ).

Make sure the problem is in the UserID.ini file

Next, we will reset the UserID.ini file completely, and see if
that fixes a problem ( there’s no sense messing around
inside the file if that isn’t the problem! ). Here’s how:

1. Click File->Login Another User ( see the Important
Tip below for why we do this )

2. Change the extension on the UserID.ini file from
ini to inix

Important Tip: GoldMine re-writes the UserID.ini file
when it shuts down, so you can not make changes to
UserID.ini files and expect them to stick unless you ensure
that the user is logged out. This also applies if you are
trying to edit the INI files directly to make changes to
settings, toolbars, etc...

3. Next, log in to GoldMine as the user in question
and confirm that the problem has gone away ( if
the problem is still occurring, fiddling with UserID.ini
will do you no good ).

4. Change the extension of the UserID.ini file back to
ini

Use divide-and-conquer to find the Culprit Section

The next step of the process is to identify which section in
the UserID.ini file is causing problems. We will selectively
delete half of the sections in the UserID.ini file and see if
the problem is fixed. If it is, then we restore the deleted
sections, then delete half of them and try again.

Here's how:
1. In GoldMine, click File->Login Another User

( Continued on Page 6 )
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( Continued from Page 6 )
2. Make a backup copy the UserID.ini file called
UserID.ini_1 ( note, the 1 will change depending
on which iteration you are doing ).

3. Open UserID.ini and scroll about half way down.
Find the nearest section start ( e.g. [CalObj] ) and
delete it and all the other sections through the
bottom of the file.

4. Save UserID.ini
5. Log in to GoldMine as the user in question
6. Check if the problem has gone away.

If the problem has not gone away, then
repeat this procedure ( deleting half of the
sections still remaining )

If the problem has gone away, then restore
from the last backup and only delete half
of what you deleted last time

Use divide-and-conquer to find the Culprit value

You can use a similar divide-and-conquer technique to
remove half of the key/value pairs in the culprit section,
and whittle it down until you find the exact key/value pair
that is causing the problem.

Fixing the problem

At this point, you have narrowed the search down to one
key/value pair ( or maybe a handful of those pairs ). What
you do at this point depends on the problem. In the vast
majority of cases, just deleting the problem statement lines
is sufficient. GoldMine will re-create the uncorrupted key/
value pair when you log in again, and you won't lose many
of your settings.

Conclusions

UserID.ini files are the source of many problems in
GoldMine, but deleting the UserID.ini file outright causes
users to lose settings. It is better to use a surgical approach
to find and address the actual problem in the UserID.ini
file instead.

As a final comment, in many cases, you can intuit the culprit
section based on the misbehavior you are experiencing.
For example, if the Calendar view is not displaying it's
bottom tabs properly, then chances are pretty good that
the issue is in the [CalObj] section.

Happy hunting!

About the Author

Kevin Day is the CTO of Trumpet, Inc. and Attach Plus,
LLC
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New GoldMine
Products for 2006
as Announced by
FrontRange

from
DJ Hunt/Gene Marks

At the convention back in November 2005, FrontRange,
the maker of GoldMine, announced a pretty ambitious year
for their developers. Here are some of the new products
they’ve announced for 2006:

GoldMine IP Voice Suite - a product that integrates
GoldMine with any Voice Over IP based phone system.

GoldMine Corporate Edition 7.1 - expect to see more
bug fixes to 7.0 plus basic service and support functionality.

GoldMine Service - a service module for GoldMine.

GoldMine Standard and Corporate Editions 8.0 -
expect more bug fixes, and a total revamping of the
GoldMine GUI to be more granular and more user friendly.
You may expect to see a more webish interface. Alas, we
may see the lose of our beloved Taskbar as well. At this
junction, all of the GoldMine products should be back in
sync as far as supported databases as well. You may
expect that the Borland Database Engine will be totally
removed for all GoldMine users in favor of ADO. You may
expect a more account centric GoldMine as well.

GoldMine Enterprise - the next generation of GoldMine
with more account and contact centric interfaces, unlimited
fields, ability to add new forms and build new relationship.
This product is being built on the .NET platform.

GoldMine MSP - a hosted version of GoldMine (ala
SalesForce.com).

Stand Alone Modules - new modules for Opportunity
Management, Lead Management, Campaign Management
and Quoting to add to the GoldMine Corporate Edition.
FrontRange is also expecting Service and Support modules,
and some that they haven't discussed as yet. We should
see everything being more granular, as FrontRange calls
it, modular as I define it. Corporations can purchase as
much or as little as they need, and will be able to always
add the plug-ins later. These plug-ins will work within the
GoldMine framework, and should integrate seamlessly
within GoldMine.

I have been discussing this modularity with FrontRange
for a couple of years now. GoldMine 7 users, and I still
don’t recommend upgrading to GoldMine 7, are seeing the
first of these implementations as more and more developers
have joined to develope their new applications as plug-ins.
The portal has opened, all we need is for the add-on
developers to begin their journey through the portal.



Tips, Tricks & Things

Query Tips
from

Byte-Size" Newsletter

These work in both dBase and SQL.

1. E-mail Inbox — There is a limitation ( 1,000 ) as to the
number of emails that can be safely displayed in GoldMine's
Inbox. We have seen a rash of problems where users
have left too many emails in their Inbox. This query will
tell you how many emails are in your Inbox. Run the query
and clean out your inbox.

select count(*),
UserID
from MailBox
where Folder = 'X-GM-INBOX'
group by UserID
order by UserID

2. Search for e-mail by domain — Want to search for all e-
mail addresses from a certain domain? Try:

select Accountno,
Company,
Contact
from Contactl
where Accountno in
(Select Accountno
from Contsupp
where RecType = 'P'
and Contact = 'E-mail Address'
and Contsupref like '%aol.com')

3. Do you need a list of all e-mail addresses with a certain
merge code? Try:

select Contactl.Company,
Contact1.Contact,
ContSupp.ContSupRef+ContSupp.Addressl1 as Email,
ContSupp.Address2

from Contactl,
Contsupp

where Contactl.Accountno = ContSupp.Accountno
and ContSupp.Contact = 'E-mail Address'
and ContSupp.MergeCodes like '%T%'

Editors Note

Gene Marks always gives me a slew of great tips for my readers.

This next tip is one that few GoldMine users know about, the ability
to update contact records during a Goldmine Import. That's right,
within GoldMine without the need of a 3rd party add-on product.

Updating Contacts with
the Import Wizard

from

Gene Marks

Can the GoldMine Import Wizard update existing contacts
as well as create new ones?

Yes, provided your import source file contains a field with
a value that exactly matches GoldMine field value in the
existing records. Provided that this GoldMine field is a
GoldMine indexed field, and finally, provided that the value
in the field is unique within GoldMine. To run an update
import:

Select Tools > Import/Export Wizard

Select Import File > Ascii Text

Click Next to until you reach the screen to map fields
Map the fields to update > click Profile Options button
Select Contact as your Match Field

Click Next > select Overwrite the Existing GoldMine
record

Click Finish and save the profile

Note: always make sure you have a backup of your
GoldMine database before running any import. There is
no recoverer from this Import process except for restoring
from a backup, hence, even though you can have people
working in GoldMine while you do your Import, in this case,
you would not want them doing so. The information in
GoldMine must not change from the point of backup
forward, until such time that the Import has been deemed
successful.

Editors Note

Gene Marks has come up with a tip that I think is fantastic, and
one that has been long asked for. On the next page you will see one
of the most useful tips that I have seen, and it answers the age old
question:

Is it possible to create a filter that searches the Conthist
table or tables other than Contactl1 or Contact2?

Alas, for Corporate Edition users only.
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Filtering on Other
Tables

from

Gene Marks

Is it possible to create a filter that searches the Conthist
table or tables other than Contact1 or Contact2?

Yes, you can create a filter and then edit the SQL Expression
to add a SQL statement to search any table including
History, Details, or Calendar.

Below is an example of a filter that includes only accounts
with a phone call or appointment completed within the last
7 days:

Create and save a Filter, any filter, such as Account is
not Empty

In the list of filters highlight the filter and click
Properties

Under the Properties tab select the SQL Query
option and click Edit Expression

Replace the initial SQL with a WHERE clause that picks
the accounts with the data you want. For this example
it is:

where c1.AccountNo in (select AccountNo from
ContHist where sRecType in (‘'A’,'C’) and OnDate
> getdate()-7 and ResultCode = ‘COM’)

Editors Note

Notice the getdate() function in the select statement. Even if it

wasn’t before, this function alone makes this select statement only
possible within a SQL environment.

I'm sorry but, you cannot copy and paste the statement from here
as this document uses special characters that are not recognized
properly by the GoldMine editor.

Click OK, Also, you do not need to edit anything in
the dBase expression window

Preview or Activate the filter to view the results

This process can be used to include SQL statements in the
Filters window instead of the SQL queries window so you
no longer need to build a SQL Query and then build a
Group from the results. Your SQL Query is how dynamic
as opposed to be static.
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